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1 Introduction 
1.1 Products Overview 
Micro Focus Enterprise Developer for z Systems 

Enterprise Developer for z Systems (EDz) supports IBM COBOL, IBM PL/I, IBM Assembler, IBM CICS, IBM 
IMS, IBM JCL, IBM DB2, IBM z/OS file formats and common batch utilities, including SORT. This means 
that you can develop and maintain the core mainframe online and batch applications under Enterprise 
Developer. 

EDz gives customers the choice to develop directly on the mainframe or under Windows. Mainframe 
applications can be developed, maintained and modernized regardless of where they will be deployed, 
either back onto the mainframe or onto an alternative server environment. Support is provided for both 
the Visual Studio and Eclipse-based IDEs and for all the development and test tools for every target 
environment currently supported by Micro Focus - including z/Linux, AIX and x86 environments. 

 

Micro Focus Enterprise Test Server 

Enterprise Test Server (ETS) is a test execution environment that allows you to test mainframe 
applications on a lower cost Windows platform. You can use variables or the tilde syntax to relieve the 
mainframe test bottleneck by allowing you to perform a substantial part of your application testing on 
Windows prior to moving the application back to the mainframe for final pre-production testing and 
deployment.       

ETS supports IBM COBOL, High Level Assembler, CICS, IMS TM and DB, JCL, DB2, and z/OS file formats. 
It also supports common batch utilities such as SORT. This means that applications running under ETS 
behave just as they would on the mainframe, so you can perform a wide variety of pre-production testing 
activities on low-cost hardware rather than on the mainframe.   

 

AWS CodeCommit 

AWS CodeCommit is a fully-managed source control service that hosts secure Git-based repositories. It 
makes it easy for teams to collaborate on code in a secure and highly scalable ecosystem. CodeCommit 
eliminates the need to operate your own source control system or worry about scaling its infrastructure. 
You can use CodeCommit to securely store anything from source code to binaries, and it works seamlessly 
with your existing Git tools. 

AWS CodeCommit eliminates the need to host, maintain, back up, and scale your own source control 
servers. The service automatically scales to meet the growing needs of your project. It has a highly 
scalable, redundant, and durable architecture. The service is designed to keep your repositories highly 
available and accessible. 

 

AWS CodePipeline 

AWS CodePipeline automates your software release process, allowing you to rapidly release new features 
to your users. With CodePipeline, you can quickly iterate on feedback and get new features to your users 
faster. 
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Automating your build, test, and release process allows you to quickly and easily test each code change 
and catch bugs while they are small and simple to fix. You can ensure the quality of your application or 
infrastructure code by running each change through your staging and release process. 

With AWS CodePipeline, you can immediately begin to model your software release process. There are no 
servers to provision or set up. CodePipeline is a fully managed continuous delivery service that connects to 
your existing tools and systems. 

 

AWS CodeBuild 

AWS CodeBuild is a fully managed continuous integration service that compiles source code, runs tests, 
and produces software packages that are ready to deploy. With CodeBuild, you don’t need to provision, 
manage, and scale your own build servers. CodeBuild scales continuously and processes multiple builds 
concurrently, so your builds are not left waiting in a queue. You can get started quickly by using 
prepackaged build environments, or you can create custom build environments that use your own build 
tools. With CodeBuild, you are charged by the minute for the compute resources you use. 

 

AWS CodeDeploy 

AWS CodeDeploy is a fully managed deployment service that automates software deployments to a 
variety of compute services such as Amazon EC2, AWS Fargate, AWS Lambda, and your on-premises 
servers. AWS CodeDeploy makes it easier for you to rapidly release new features, helps you avoid 
downtime during application deployment, and handles the complexity of updating your applications. You 
can use AWS CodeDeploy to automate software deployments, eliminating the need for error-prone manual 
operations. The service scales to match your deployment needs. 

 

AWS Lambda 

AWS Lambda lets you run code without provisioning or managing servers (serverless). You pay only for 
the compute time you consume. With Lambda, you can run code for virtually any type of application or 
backend service - all with zero administration. Just upload your code and Lambda takes care of everything 
required to run and scale your code with high availability. You can set up your code to automatically 
trigger from other AWS services or call it directly from any web or mobile app. 

 

1.2 Documentation 
Micro Focus Enterprise Developer 5.0 for Eclipse documentation: 

https://www.microfocus.com/documentation/enterprise-developer/ed50/ED-Eclipse/GUID-8D6B7358-
AC35-4DAF-A445-607D8D97EBB2.html 

 

Micro Focus Enterprise Test Server 5.0 documentation: 

https://www.microfocus.com/documentation/enterprise-developer/ed50/ETS-help/GUID-ECA56693-D9FE-
4590-8798-133257BFEBE7.html 

 

AWS CodeCommit documentation: 
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https://docs.aws.amazon.com/codecommit/latest/userguide/welcome.html 

 

AWS CodeBuild documentation: 

https://docs.aws.amazon.com/codebuild/latest/userguide/welcome.html 

 

AWS CodeDeploy documentation: 

https://docs.aws.amazon.com/codedeploy/latest/userguide/welcome.html 

 

AWS CodePipeline documentation: 

https://docs.aws.amazon.com/codepipeline/latest/userguide/welcome.html 

 

AWS Lambda documentation: 

https://docs.aws.amazon.com/lambda/latest/dg/welcome.html 

 

AWS Systems Manager documentation: 

https://docs.aws.amazon.com/systems-manager/latest/userguide/what-is-systems-manager.html 

 

1.3 CI/CD pipeline description 
This document describes how to configure a COBOL Continuous Integration / Continuous Delivery (CI/CD) 
pipeline using Micro Focus (MF) and Amazon Web Services (AWS) components. 

You can learn more about the pipeline incremental approach and components in this blog post: 

https://aws.amazon.com/blogs/industries/enable-agile-mainframe-development-test-and-ci-cd-with-aws-
and-micro-focus/  

This pipeline is modular. This means you can swap some of the tools and you can decide to configure one 
stage but not the others.  

The pipeline includes Micro Focus Enterprise Developer (MF EDz), Micro Focus Enterprise Test Server (MF 
ETS). 
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The CI/CD pipeline shown above executes the following steps: 

1. A developer makes changes to the source code and commits the changes to the local Git 
repository. These source code changes are pushed to the upstream repository hosted by AWS 
CodeCommit.  

2. The source code changes in CodeCommit trigger an AWS CloudWatch event which starts the 
pipeline in AWS CodePipeline. 

3. The pipeline calls AWS CodeBuild in order to start the build phase. 
4. AWS CodeBuild provisions a build environment in a container with Micro Focus Enterprise 

Developer Build tools.  
5. This container is based on a container image pulled from Amazon Container Registry. 
6. Once the container is provisioned, the build environments download the source code from AWS 

CodeCommit. The source code is compiled and linked. 
7. Then the compiled code is uploaded in an Amazon S3 buckets which stores the generated build 

artifacts. 
8. The build phase being complete, the pipeline calls AWS CodeDeploy as part of the test phase. 
9. AWS CodeDeploy send code deployment instructions to the CodeDeploy agent residing on the 

Amazon EC2 instance hosting Micro Focus Enterprise Test Server. 
10. The AWS CodeDeploy agent pulls the compiled code from the S3 bucket with the artifacts and 

deploys it to the proper destination folders and restarts Micro Focus Enterprise Test Server. 
11. Once the code is deployed, the pipeline calls AWS Lambda to start the tests.  
12. AWS Lambda sends the test command to the Amazon EC2 test instance via Amazon Systems 

Manager (SSM). The test command triggers a batch test script on the test instance.  The batch test 
script calls a Visual Basic script with can either trigger a Rumba or a UFT automation script. The 
test script executes test cases against the modified compiled code and Micro Focus Enterprise Test 
Server verifying the new code is operational. The result of the tests is sent back to the pipeline in 
AWS CodePipeline. 
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13. If tests are successful, the pipeline calls AWS Lambda in order to send the source code back to the 
mainframe Source Code Management (SCM) system.  

14. The AWS Lambda function retrieves the code changes from AWS Code Commit, and processes the 
modified files for deploying to production. We show one option for deploying with z/OS FTP server. 

 

1.4 Configuration samples 
In order to facilitate the configuration of this pipeline, we have made available some reusable sample 
configuration files on GitHub: https://github.com/aws-samples/mainframe-cobol-cicd-pipeline-aws-
microfocus  

For example, you will find the Lambda functions and the CodeBuild or CodeDeploy configuration files on 
GitHub. 

 

1.5 Feedback 
We are glad to improve this pipeline, the configuration samples, and this documentation. If you have 
comments, suggestions, or challenges, feel free to let us know and we will be glad to help. You can 
contact us via your AWS representative, your Micro Focus representative, or by opening an issue on 
GitHub: https://github.com/aws-samples/mainframe-cobol-cicd-pipeline-aws-microfocus/issues  
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2 Development environment 
2.1 DEV – MF EDz configuration for Bankdemo 
For getting access to Micro Focus software, please contact your Micro Focus representative or contact 
Micro Focus following this link: https://www.microfocus.com/en-us/contact/contactme   

First you need to retrieve an AMI with Micro Focus Enterprise Developer (EDz) or deploy the EDz software 
on an EC2 instance. 

 

If you retrieve Micro Focus software from an AMI, launch EC2 instance from Micro Focus EDz AMI. 

 

Once started, choose to Connect to the instance. 

 

Download Remote Desktop File and Get Password 

 

Decrypt password. 

Open RDP file and connect to instance with Administrator username and decrypted password. 

 

Start Enterprise Developer for Eclipse 
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Go to Application Explorer view 

 

 

Right-click Enterprise Development Projects, which is the node for the standard application. 

Click New Project from Template. 

You can find more details for help at this link:  

https://www.microfocus.com/documentation/enterprise-developer/ed50/ED-Eclipse/GUID-5A27996B-
F03D-471A-ACDF-36E680E5939E.html 

 

 

Browse to the C:\Users\Public\Documents\Micro Focus\Enterprise 
Developer\Samples\Mainframe\BankDemo\Workspace\Bankdemo and click Select Folder. 

Type Bankdemo in the project name field and click OK. 
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This creates a copy of the Bankdemo project in your Eclipse workspace and adds the project to the 
application in the Application Explorer view. If the Bankdemo project entry is not displayed in the tree 
view, refresh the Enterprise Development Projects entry. 

 

Add the demo source files, in Application Explorer view, right-click the Bankdemo project, and click 
Import… 

 

Next 

 

Select folder C:\Users\Public\Documents\Micro Focus\Enterprise 
Developer\Samples\Mainframe\BankDemo\MFETDUSER\BankDemo 
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Select Source subdirectory. 

Click Finish. 

This adds the folders storing the source files to your project as imported resources: 

 

 

By default, Eclipse is set to build projects automatically (see Project > Build Automatically), so it 
immediately compiles the files you have just added. 

Check the Console and Problems views and see that some of the programs failed to compile. In 
Application Explorer view, you can select a program and check the error and warning count property in the 
Properties view to indicate that there are compilation problems. 

The errors are due to the correct copybook paths not being specified in the project properties. 

 

Right-click Bankdemo and click Determine Directives. 
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The IDE performs a scan of the files and shows a report of what directives for dialect and for CICS must 
be set on the programs in your project in order for them to compile cleanly. 

 

 

Click OK to set the directives. 

If you are prompted to delete some user files, choose No. 

 

Setting the missing Compiler directives triggers a full rebuild of the project. There are still some errors in 
the COBOL sources due to the fact that the project cannot resolve the paths to the copybook files. 

 

Then we specify the copybook paths for the project. 

In Application Explorer view, right-click the Bankdemo project, and click Properties. 

Expand Micro Focus, and then click Build Path. 

Click the Dependency Paths tab and ensure Type is set to COBOL Copybook Paths. 

Check the Bankdemo/Sources/copybook entry in the list, and then click Apply and Close. 



Amazon Web Service – Micro Focus   Page 14 of 95 
COBOL CI/CD Pipeline Configuration Guide V1.1 

 

Eclipse rebuilds the project and now all COBOL programs should compile cleanly. 

 

 

 

 

2.2 DEV – MF EDz configuration for Bankdemo unit test 
server 

You can find more details for help at this link: 
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https://www.microfocus.com/documentation/enterprise-developer/ed50/ED-Eclipse/GUID-CA516B8B-
0435-426B-859F-DBFF8026B813.html  

 

Click the Server Explorer tab. If the tab is not visible, click Window > Show View > Other. Select Micro 
Focus > Server Explorer and then click Open. 

 

 

First, we import the Bankdemo server. 

In Server Explorer, right-click Local [localhost:86] and click Open Administration Page. 

 

 

 

Click Import in the left upper corner of Enterprise Server Administration. 

On the Import server information page and under Recent directories click the directory for the BANKDEMO 
server. 
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This adds the path to the Selected source directory containing server data to restore field. 

Click Next 3 times and then OK to import the BankDemo server (keep the BankDemo server in 32 bit). 

 

The system returns to the main Enterprise Server Administration page. 

 

You can see the Bankdemo server appears in the list of servers.  

 

In front of the BANKDEMO server, select Edit… 
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Under Configuration Information, update the ESP variable path to the actual location on EDz:  

ESP=C:\Users\Public\Documents\Micro Focus\Enterprise 
Developer\Samples\Mainframe\BankDemo\MFETDUSER\BankDemo\System 

Click OK to save. 

 

Make sure the CICS paths for SysLoadlib configuration match the file system. 
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Be careful with the SysLoadlib case. You may have to adjust the folder name for proper upper-case 
letters. 

 

For the Bankdemo project, under Properties -> Resource -> Linked Resources -> Path Variables, Edit the 
loadlib variable to match the BANKDEMO server loadlib folder in C:\Users\Public\Documents\Micro 
Focus\Enterprise Developer\Samples\Mainframe\BankDemo\MFETDUSER\BankDemo\System\sysloadlib 
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Then choose Apply and Close. 

Clean the Bankdemo project to rebuild. 

 

Then we associate the Bankdemo Enterprise Server with the application project. 

In Server Explorer, right-click Local, and click Refresh to show the BankDemo server. If you get a 
Directory Server offline message appears, restart EDz. 

 

Right-click the BANKDEMO server, point to Associate with project, then select Bankdemo. 

 

 

Configure EDz to start the associated BankDemo server automatically as follows. Click Window > 
Preferences. 

Expand Micro Focus, and click Enterprise Server. 

Set the following options on this page to Always in order to enable the IDE to start or stop the associated 
server, and to enable dynamic debugging, for when it is not enabled in the server: 

Automatically start the associated server - this ensures the IDE will start the server if it is not running 
when you execute the application. 

Automatically stop servers started by Eclipse when closing Eclipse - this enables the IDE to stop servers 
when you close Eclipse. 

Automatically enable dynamic debugging - this ensures the IDE will check whether the server has dynamic 
debugging enabled and, if it is not, will enable it when you start debugging. 
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Click Apply and Close. 

 

In the Server Explorer window, right-click the Bankdemo server and then click Start. 

Wait until the server has started. In the list of servers in Server Explorer, BANKDEMO still has a red 
square next to it. This is a refresh delay. 

 

If any server start problem you can check the logs doing a right-click on BANKDEMO server then Show 
Console Log or in C:\Users\Public\Documents\Micro Focus\Enterprise 
Developer\Samples\Mainframe\BankDemo\MFETDUSER\BankDemo\System\Logs\console.txt. 

 

 

2.3 DEV – MF EDz BankDemo online unit test 
You can find more details for help at this link:  

https://www.microfocus.com/documentation/enterprise-developer/ed50/ED-Eclipse/index.html?t=GUID-
A0221822-CF44-4698-ABD6-7F77F7A862A2.html  

 

In the EDz IDE, click Window > Preferences. 

Expand Micro Focus > Enterprise Server, and click TN3270. 

Ensure that Enable display, Rumba (Embedded) and Connect automatically are all selected. 
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Click OK. 

 

Right-click the BANKDEMO server in Server Explorer, and click Show TN3270 Display. 

This opens the Rumba+ Desktop Mainframe Display view and automatically establishes a 3270 terminal 
connection to the BANKDEMO server. You can see the starting page of the ES/MTO region BANKDEMO. 

 You can drag the Rumba Mainframe Display view to reposition it. 

 

 

Press Ctrl+Shift+Z to clear this window. 

Type in the transaction id BANK and press Enter (Crtl) to navigate to an application logon window. 
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Type your logon details and press Enter. A suitable User Id is b0001. You can type anything as a Password 
- the field must not be empty though. 

 

 

Type / against Display your account balances and press Enter to see the details for this customer. 
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You can explore this application further if you wish or press F3 to terminate it. 
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3 SOURCE stage 
3.1 SOURCE – MF EDz and AWS CodeCommit integration 
You can find more details for help at this link:  

https://docs.aws.amazon.com/codecommit/latest/userguide/setting-up-ide-ec.html  

 

In AWS IAM, create a new AWS user for integration 

 

 

 

Attach the AWSCodeCommitPowerUser policy and create User.  

Download and save the Access Key and the Secret Access Key. 
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Select the User, then Under Security Credentials, go to HTTPS Git credentials for AWS CodeCommit and 
click Generate credentials. 

 

 

 

Download and save the credentials. 

 

 

 

 

Back to the MF EDz instance, Install the AWS Toolkit for Eclipse with the following instructions. 
Instructions can be found here: https://aws.amazon.com/eclipse/  

 

Within Eclipse, click Help and then click Install New Software. 

 

In the Work with field, type https://aws.amazon.com/eclipse and then press Enter. 
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Select the main AWS components and click Next, then review packages, accept license and install. 

 

 

 

 

 

After restart, enter the Access Key and Secret Access Key for the CICD-User. 

 



Amazon Web Service – Micro Focus   Page 27 of 95 
COBOL CI/CD Pipeline Configuration Guide V1.1 

It will then show in the Eclipse Preferences 

 

 

 

Under AWS Toolkit => Regions, verify or set your desired region for your setup. 

 

 

Expand the AWS Toolkit menu and choose AWS CodeCommit. Enter the user name and password for your 
Git credentials importing them from the .csv file. Choose Apply, and then choose OK. 
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Save with Apply and Close. 

 

 

 

In AWS Explorer, right-click on AWS CodeCommit and click Create Repository. 

 

 

 

Enter the Repository Name: MF-AWS-CICD-SCM 

Enter the Repository Description: Source Code Management for MF & AWS CICD pipeline 
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It can be opened in CodeCommit Repository Editor. 

 

 

 

And also shows in AWS console: 

 

 

In AWS CodeCommit, create a dummy file (this creates the master branch in the repository). 

  

 

In Eclipse AWS Explorer choose Clone Repository 
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The master branch was created by the dummy file. 

Click Next. 

 

Click Finish. 
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3.2 SOURCE – MF EDz to AWS CodeCommit code push 
Now that we have a local clone of our repository, we’re ready to start putting the BankDemo source code 
into the Git local clone repository.  

Select BankDemo project and use Team -> Share Project… to connect that project with the repository we 
just cloned. 

 

Select the local Git repository in the working tree: C:\Users\Administrator\git\MF-AWS-CICD-SCM 

 

 

 

If you see the above error message, delete the C:\Users\Administrator\git\MF-AWS-CICD-SCM\.project 
file and redo Select BankDemo project and use Team -> Share Project… 
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Click Finish. Bankdemo will then recompile/rebuild. You will then notice the Bankdemo project associated 
with the cloned local Git. 

 

 

 

On the Bankdemo project, select Team -> Commit 

 

 

Add all Unstaged Changes to Staged Changes 

 

 

Enter a Commit Message and click Commit. 

Changes are committed to the local cloned Git repository. 

 

On the Bankdemo project, select Team -> Push to Upstream to push the source code to CodeCommit. 
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You can then see the code pushed to CodeCommit via the Repository Editor 

 

 

And you can see all the files from AWS Console in CodeCommit: 
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4 BUILD stage 
 

4.1 BUILD – Amazon ECR docker image with Micro Focus 
build tools 

 

For getting access to Micro Focus software, please contact your Micro Focus representative or contact 
Micro Focus following this link: https://www.microfocus.com/en-us/contact/contactme   

For this section we need the Micro Focus Build tools packaged as Docker containers. In our example, these 
containers are initially stored in AWS S3. 

Create an EC2-to-S3-ECR-microfocus-aws IAM role with inline policy 

{ 
    "Version": "2012-10-17", 
    "Statement": [ 
        { 
            "Effect": "Allow", 
            "Action": [ 
                "s3:Get*", 
                "s3:List*" 
            ], 
            "Resource": "arn:aws:s3:::microfocus-aws/*" 
        }, 
        { 
            "Effect": "Allow", 
            "Action": [ 
                "ecr:ListTagsForResource", 
                "ecr:UploadLayerPart", 
                "ecr:ListImages", 
                "ecr:CompleteLayerUpload", 
                "ecr:DescribeRepositories", 
                "ecr:BatchCheckLayerAvailability", 
                "ecr:GetLifecyclePolicy", 
                "ecr:DescribeImageScanFindings", 
                "s3:ListAccessPoints", 
                "ecr:GetLifecyclePolicyPreview", 
                "ecr:GetDownloadUrlForLayer", 
                "ecr:GetAuthorizationToken", 
                "ecr:PutImage", 
                "ecr:BatchGetImage", 
                "ecr:DescribeImages", 
                "ecr:InitiateLayerUpload" 
            ], 
            "Resource": "*" 
        } 
    ] 
} 

 

Launch a new EC2 instance with “Microsoft Windows Server 2016 Base with Containers” (because AWS 
CodeBuild executes Windows Server containers using Windows Server 2016 hosts). This instance is 
temporary to prepare and push the container image to Amazon ECR. 
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Include the EC2-to-S3-ECR-microfocus-aws role 

 

Allocate 256 GB of disk space 

 

 

Log on to the instance. 

 

Start Command Prompt as an administrator. 

Check the docker version in your instance: 

docker version 
Client: 
 Version:      1.12.2-cs2-ws-beta 
 API version:  1.25 
 Go version:   go1.7.1 
 Git commit:   050b611 
 Built:        Tue Oct 11 02:35:40 2016 
 OS/Arch:      windows/amd64 
 
Server: 
 Version:      1.12.2-cs2-ws-beta 
 API version:  1.25 
 Go version:   go1.7.1 
 Git commit:   050b611 
 Built:        Tue Oct 11 02:35:40 2016 
 OS/Arch:      windows/amd64 

 

If the docker version is not Docker Enterprise v19 (like the above is not the proper version), we need to 
install it with the following instructions: 

start powershell 

In the new Administrator PowerShell windows, enter commands: 

Install-Module DockerMsftProvider -Force 
Install-Package Docker -ProviderName DockerMsftProvider -Force 

 

Start Docker Enterprise 

net start docker 
The Docker Engine service is starting. 
The Docker Engine service was started successfully. 
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Check the new docker version in your instance: 

docker version 
Client: Docker Engine - Enterprise 
 Version:           19.03.5 
 API version:       1.40 
 Go version:        go1.12.12 
 Git commit:        2ee0c57608 
 Built:             11/13/2019 08:00:16 
 OS/Arch:           windows/amd64 
 Experimental:      false 
 
Server: Docker Engine - Enterprise 
 Engine: 
  Version:          19.03.5 
  API version:      1.40 (minimum version 1.24) 
  Go version:       go1.12.12 
  Git commit:       2ee0c57608 
  Built:            11/13/2019 07:58:51 
  OS/Arch:          windows/amd64 
  Experimental:     false 

Docker Enterprise v19 is good and we can proceed. 

Reboot the instance. 

 

Download AWS CLI installer from https://s3.amazonaws.com/aws-cli/AWSCLI64PY3.msi 

Run CLI Setup installer. 

 

Then copy the Micro Focus docker container file from your S3 bucket: 

aws s3 cp s3://microfocus-aws/ed_build_tools_dockerfiles_5.0_windows_pu05.zip . 
download: s3://microfocus-aws/ed_build_tools_dockerfiles_5.0_windows_pu05.zip to 
./ed_build_tools_dockerfiles_5.0_windows_pu05.zip 

Extract the zip file. 

In the extracted location, copy in the correct license file (.mflic) for that product 

 

Also copy the C:\MicroFocus_Software\EDBT\edbt_50.exe from the EDz instance to the extracted folder. 

From the extracted folder, run bld.bat IacceptEULA which will build the container images for you 

bld.bat IacceptEULA 

 

If you receive an error message such as the following, you likely don’t have Docker Enterprise v19 
installed and see previous steps to install it. 

Step 1/26 : ARG BASE_SUFFIX= 
Please provide a source image with `from` prior to commit 
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Build output: 
Complete - We have the following microfocus/edbuildtools images 
microfocus/edbuildtools-build   win_5.0_x64          948ea87022be        1 second ago        18.9GB 
microfocus/edbuildtools-build   win_5.0_x86          7b3542d7d007        25 seconds ago      18.9GB 
microfocus/edbuildtools-build   win_5.0              bfd78b3a744a        58 seconds ago      18.8GB 
microfocus/edbuildtools         win_5.0_x64          fe1cb18df2da        18 minutes ago      16.3GB 
microfocus/edbuildtools         win_5.0_x86          436dfcb8a69b        18 minutes ago      16.3GB 
microfocus/edbuildtools         win_5.0              512178790dfa        50 minutes ago      16.2GB 

 

You can then display images with: 

docker image ls 
REPOSITORY                      TAG                  IMAGE ID            CREATED             SIZE 
microfocus/edbuildtools-build   win_5.0_x64          948ea87022be        25 minutes ago      18.9GB 
microfocus/edbuildtools-build   win_5.0_x86          7b3542d7d007        25 minutes ago      18.9GB 
microfocus/edbuildtools-build   win_5.0              bfd78b3a744a        25 minutes ago      18.8GB 
microfocus/edbuildtools         win_5.0_x64          fe1cb18df2da        43 minutes ago      16.3GB 
microfocus/edbuildtools         win_5.0_x86          436dfcb8a69b        43 minutes ago      16.3GB 
microfocus/edbuildtools         win_5.0              512178790dfa        About an hour ago   16.2GB 
microsoft/dotnet-framework      4.7.2-runtime        da6e6a287bce        4 weeks ago         13.3GB 
microsoft/dotnet-framework      4.7.2-sdk            bab65b1f870b        4 months ago        15.8GB 
hello-world                     nanoserver-sac2016   2c911f8d79db        13 months ago       1.17GB 

 

Explore the edbuildtools-build win_5.0_x64 docker image with commands similar to the followings:           

docker run -it 948ea87022be cmd 
dir 
exit 

 

In Amazon ECR, create a repository to store the docker image. 
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Enter repository name: mf-aws-cicd-container-repository, then select Create repository. 

 

 

Click View push commands 
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Copy-paste the commands which will be customized to push the docker image from the temporary EC2 
instance to Amazon ECR. 

Invoke-Expression -Command (Get-ECRLoginCommand -Region us-east-1).Command 
docker build -t mf-aws-cicd-container-repository . 
docker tag mf-aws-cicd-container-repository:latest 954254376221.dkr.ecr.us-east-1.amazonaws.com/mf-aws-cicd-container-repository:latest 
docker push 954254376221.dkr.ecr.us-east-1.amazonaws.com/mf-aws-cicd-container-repository:latest 

 

Click on the mf-aws-cicd-container-repository name, then select Permissions. 

 

Under Permissions – Statements, click Edit to create one, then choose Add statement. 

Enter CodeBuildAccess for the Statement name. 

Enter codebuild.amazonaws.com for the Service principal. 
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For Actions, select the pull-only actions ecr:GetDownloadUrlForLayer, ecr:BatchGetImage, and 
ecr:BatchCheckLayerAvailability. 

 

Click Save. 

 

 

 

Back in the temporary EC2 instance with the build images, start a PowerShell window and run this 
command to login to Amazon ECR: 

Invoke-Expression -Command (Get-ECRLoginCommand -Region us-east-1).Command 
WARNING! Using --password via the CLI is insecure. Use --password-stdin. 
WARNING! Your password will be stored unencrypted in C:\Users\Administrator\.docker\config.json. 
Configure a credential helper to remove this warning. See 
https://docs.docker.com/engine/reference/commandline/login/#credentials-store 
Login Succeeded 
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From the list of images previously displayed, find the image ID for the microfocus/edbuildtools-build 
win_5.0_x64 image which is 948ea87022be in our example). Then incorporate the image ID in the 
following command and run the command to tag the image:            

docker tag 948ea87022be 954254376221.dkr.ecr.us-east-1.amazonaws.com/mf-aws-cicd-container-
repository:edbuildtools-build-win_5.0_x64    

 

Then push this image in the Amazon ECR repository: 

docker push 954254376221.dkr.ecr.us-east-1.amazonaws.com/mf-aws-cicd-container-
repository:edbuildtools-build-win_5.0_x64 
 

 

 

On the Amazon ECR side, you can then see the new image in the repository 
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4.2 BUILD – AWS CodeBuild configuration 
In EDz, select Help -> Eclipse Marketplace… Enter yaml in Find field and search. 

 

Install Wild Web Developer. It facilitates the editing of Yaml files that we will create next. 

 

In EDz Bankdemo project, select New -> Folder -> Folder… and create an AWS-CICD folder. 

You may need to Refresh Resource (F5) to see it. 

 

 

In this AWS-CICD folder, select New -> File -> Other File… and create a buildspec.yml file.  
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The buildspec.yml file is a build specification file which contains a collection of build commands and related 
settings, in YAML format, that CodeBuild uses to run a build. 

Details about the buildspec.yml file and syntax are here: 
https://docs.aws.amazon.com/codebuild/latest/userguide/build-spec-ref.html  

Buildspec.yml commands run in a Windows Server Core 2016 image using the Powershell shell. 

 

Edit the buildspec.yml file: 
version: 0.2 
 
env: 
  variables: 
    SOURCE_COBOL_FOLDER: .\Bankdemo\Sources\cbl 
    AWS_CICD_FOLDER: .\Bankdemo\AWS-CICD 
    COBCPY: .\Bankdemo\Sources\copybook;C:\EDTools\cpylib # where to find copybooks such as DFHAID and 
application copybooks 
    COBOL_EXE_PATH_FILE: C:\EDTools\bin\cobol.exe 
    CBLLINK_EXE_PATH_FILE: C:\EDTools\bin\cbllink.exe 
    COBOL_COMPILER_DIRECTIVES: 
"preprocess(EXCI),CICSECM(),CHARSET(EBCDIC),DIALECT(ENTCOBOL),SOURCEFORMAT(fixed),NOPANVALET,NOLIBRARIAN
,ANIM,EXITPROGRAM(ANSI),WARNING(1),MAX-ERROR(100)" 
    COBDIR: C:\EDTools # where to find the message file 
 
phases: 
  pre_build: 
    commands: 
      - echo =============================================================================== 
      - echo Variables 
      - 'echo SOURCE_COBOL_FOLDER: $env:SOURCE_COBOL_FOLDER' 
      - 'echo AWS_CICD_FOLDER: $env:AWS_CICD_FOLDER' 
      - 'echo COBOL_COMPILER_DIRECTIVES: $env:COBOL_COMPILER_DIRECTIVES' 
      - 'echo COBOL_EXE_PATH_FILE: $env:COBOL_EXE_PATH_FILE' 
      - 'echo CBLLINK_EXE_PATH_FILE: $env:CBLLINK_EXE_PATH_FILE' 
      - 'echo COBDIR: $env:COBDIR' 
      - 'echo COBCPY: $env:COBCPY' 
      - dir 
      - dir  $env:SOURCE_COBOL_FOLDER 
      
  build: 
    commands: 
      - echo =============================================================================== 
      - echo "Compiling begins" 
      - foreach ($f in Get-ChildItem $env:SOURCE_COBOL_FOLDER -Filter "*.cbl") {  
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            echo -------------------------------------------------------------------------------; 
            echo "Compiling $($f.FullName)"; 
            & $env:COBOL_EXE_PATH_FILE "$($f.FullName),,,$($env:COBOL_COMPILER_DIRECTIVES);"; 
            } 
      - echo ------------------------------------------------------------------------------- 
      - echo "Compiling ends" 
      - echo "" 
      - echo =============================================================================== 
      - echo "Linking begins" 
      - foreach ($f in Get-ChildItem "." -Filter "*.obj") {  
            echo -------------------------------------------------------------------------------; 
            echo "Linking $($f.FullName)"; 
            & $env:CBLLINK_EXE_PATH_FILE -d $f.FullName; 
            } 
      - echo ------------------------------------------------------------------------------- 
      - echo "Linking ends" 
 
  post_build: 
    commands: 
      - echo =============================================================================== 
      - echo "Preparing build output files for packaging" 
      - mkdir ./dll 
      - cp *.dll ./dll 
      - cp $env:AWS_CICD_FOLDER/* . 
      - compress-archive -path ./dll -destinationpath ./deploy.zip 
      - compress-archive -path $env:AWS_CICD_FOLDER/* -update -destinationpath ./deploy.zip 
 
artifacts: 
  files: 
    - deploy.zip                    # For CodeDeploy manual deployment 
    - appspec.yml                   # For CodePipeline automated deployment 
    - codedeploy-before-install.bat # For CodePipeline automated deployment 
    - codedeploy-after-install.bat  # For CodePipeline automated deployment 
    - dll/*                         # For CodePipeline automated deployment 
  discard-paths: no 

Save this buildspec.yml file. 

Commit and push this change to CodeCommit. 

 

In S3, create a S3 bucket for the build artefact. We use mf-aws-cicd-artifacts in our example. 

 

 

Go to CodeBuild 

 

Click Create build project. 
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Enter the project name: MF-AWS-CICD-Build. 

 

Select CodeCommit provider, MF-AWS-CICD-SCM repository, master branch. 
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Select a Custom image (Docker image) of Windows type within the Amazon ECR registry in My ECR 
account within mf-aws-cicd-container-repository named edbuildtools-build-win_5.0_x64. We use AWS 
CodeBuild credentials and a New service role named codebuild-mf-aws-cicd-build-service-role. 

 

 

We use a buildspec file in the following location: Bankdemo/AWS-CICD/buildspec.yml 

 

Under Artifacts, choose the Amazon S3 and mf-aws-cicd-artifacts bucket. 
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For the Logs, we store build output logs in CloudWatch. 

 

 

Click Create build project. 

 

 

 

Click Start build. 
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With a successful build, the artifacts are created in S3. 
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4.3 BUILD – AWS CodePipeline configuration 
 

 

In CodePipeline, select Pipelines then click Create pipeline 
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Enter the pipeline name: MF-AWS-CICD-Pipeline. 

We select Default location for the artifact store, meaning we will not reuse the one created for CodeBuild 
and CodeDeploy previously but we’ll use one which is automatically generated by CodePipeline. 

Click Next. 
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Select the CodeCommit repository and branch, then click Next. 

 

 

Click Next 
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Click Skip deploy stage. 

Click Create pipeline. 
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5 DEPLOY to TEST stage 
5.1 DEPLOY to TEST – MF ETS configuration for CodeDeploy 
 

In AWS console, create an IAM role for CodeDeploy access. 

You can find more help for these steps at this link: 
https://docs.aws.amazon.com/codedeploy/latest/userguide/getting-started-create-iam-instance-
profile.html 

 

Create an EC2-to-S3-CodeDeploy-microfocus-aws-readonly IAM role with inline policy: 

{ 
    "Version": "2012-10-17", 
    "Statement": [ 
        { 
            "Effect": "Allow", 
            "Action": [ 
                "s3:Get*", 
                "s3:List*" 
            ], 
            "Resource": [ 
                "arn:aws:s3:::mf-aws-cicd-artifacts/*", 
                "arn:aws:s3:::aws-codedeploy-us-east-2/*", 
                "arn:aws:s3:::aws-codedeploy-us-east-1/*", 
                "arn:aws:s3:::aws-codedeploy-us-west-1/*", 
                "arn:aws:s3:::aws-codedeploy-us-west-2/*", 
                "arn:aws:s3:::aws-codedeploy-ca-central-1/*", 
                "arn:aws:s3:::aws-codedeploy-eu-west-1/*", 
                "arn:aws:s3:::aws-codedeploy-eu-west-2/*", 
                "arn:aws:s3:::aws-codedeploy-eu-west-3/*", 
                "arn:aws:s3:::aws-codedeploy-eu-central-1/*", 
                "arn:aws:s3:::aws-codedeploy-ap-east-1/*", 
                "arn:aws:s3:::aws-codedeploy-ap-northeast-1/*", 
                "arn:aws:s3:::aws-codedeploy-ap-northeast-2/*", 
                "arn:aws:s3:::aws-codedeploy-ap-southeast-1/*", 
                "arn:aws:s3:::aws-codedeploy-ap-southeast-2/*", 
                "arn:aws:s3:::aws-codedeploy-ap-south-1/*", 
                "arn:aws:s3:::aws-codedeploy-sa-east-1/*", 
                "arn:aws:s3:::codepipeline-us-east-2-*", 
                "arn:aws:s3:::codepipeline-us-east-1-*", 
                "arn:aws:s3:::codepipeline-us-west-1-*", 
                "arn:aws:s3:::codepipeline-us-west-2-*", 
                "arn:aws:s3:::codepipeline-ca-central-1-*", 
                "arn:aws:s3:::codepipeline-eu-west-1-*", 
                "arn:aws:s3:::codepipeline-eu-west-2-*", 
                "arn:aws:s3:::codepipeline-eu-west-3-*", 
                "arn:aws:s3:::codepipeline-eu-central-1-*", 
                "arn:aws:s3:::codepipeline-ap-east-1-*", 
                "arn:aws:s3:::codepipeline-ap-northeast-1-*", 
                "arn:aws:s3:::codepipeline-ap-northeast-2-*", 
                "arn:aws:s3:::codepipeline-ap-southeast-1-*", 
                "arn:aws:s3:::codepipeline-ap-southeast-2-*", 
                "arn:aws:s3:::codepipeline-ap-south-1-*", 
                "arn:aws:s3:::codepipeline-sa-east-1-*"            ]         
         } 
        ] 
} 

Create CodeDeploy-to-EC2-microfocus-aws IAM role with the attached AWSCodeDeployRole policy. 
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Copy the Role ARN for this role such as arn:aws:iam::954254376221:role/CodeDeploy-to-EC2-
microfocus-aws 

 

For getting access to Micro Focus software, please contact your Micro Focus representative or contact 
Micro Focus following this link: https://www.microfocus.com/en-us/contact/contactme   

First you need to retrieve an AMI with Micro Focus Enterprise Test Server (ETS) or deploy the ETS 
software on an EC2 instance. 

Select Micro Focus Enterprise Test Server (ETS) AMI and click Launch. 

Under Configure Instance Details, choose the EC2-to-S3-CodeDeploy-microfocus-aws-readonly role. 

 

Under Advanced Details User data, enter the following commands to install CodeDeploy agent: 
<powershell> 
Set-ExecutionPolicy RemoteSigned -Force 
Import-Module AWSPowerShell 
$REGION = (ConvertFrom-Json (Invoke-WebRequest -Uri http://169.254.169.254/latest/dynamic/instance-
identity/document -UseBasicParsing).Content).region 
New-Item -Path c:\temp -ItemType "directory" -Force 
powershell.exe -Command Read-S3Object -BucketName aws-codedeploy-$REGION -Key latest/codedeploy-agent-
updater.msi -File c:\temp\codedeploy-agent-updater.msi 
// Start-Sleep -Seconds 30 *optional 
c:\temp\codedeploy-agent-updater.msi /quiet /l c:\temp\host-agent-updater-log.txt 
</powershell> 

 

 

Add a tag with Key CodeDeployGroup and Value ETS-MF-AWS-CICD. 
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Then Launch the EC2 instance. 

 

Connect to the launched instance and verify the CodeDeploy agent is installed and started: 

 

 

We’re now going to configure a BankDemo test server on ETS. 

 

Zip and copy the BankDemo folder within C:\Users\Public\Documents\Micro Focus\Enterprise 
Developer\Samples\Mainframe\BankDemo\MFETDUSER from the EDz instance, and extract it on the ETS 
instance right under the root directory C:\. Be careful not to extract it under C:\BankDemo\BankDemo 
(folder duplicated). 

 

 

Verify the C:\BankDemo\System\SysLoadlib folder has the proper letters in upper-case (S and L). 
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With a browser, go to the Enterprise Server Administration at http://localhost:86/ 

 

Click Import in the left upper corner of Enterprise Server Administration. 

On the Import server information page and under Recent directories click the directory for the BANKDEMO 
server. 
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This adds the path to the Selected source directory containing server data to restore field. 

Click Next 3 times and click OK to import the BankDemo server (keep the server in 32-bit). 

 

The system returns to the main Enterprise Server Administration page. 

 

 

You can see the Bankdemo server appears in the list of servers.  

 

In front of the BANKDEMO server, select Edit… 
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Under Configuration Information, update the ESP variable path to the actual location on ETS instance:  

ESP=C:\BankDemo\System 

Click OK to save. 

 

Under the Enterprise Server Administration, click Start for the BANKDEMO server… 

 

 

If any server start problem you can check the console log in C:\BankDemo\System\Logs\console.txt. 

 

The BankDemo compiled dll files will go in C:\BankDemo\System\SysLoadlib 

 

Run C:\ProgramData\Amazon\EC2-Windows\Launch\Settings\Ec2LaunchSettings.exe 
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Click Shutdown with Sysprep  

 

Click Yes. 

 

Once the ETS instance is stopped (not terminated), create an AMI from it: Micro Focus ETS with 
BankDemo.  
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This new AMI will be used in case you need to terminate and start new ETS instances with BankDemo 
server already configured. 

 

Every time you start a new EC2 instance for ETS with BankDemo, verify you have the role EC2-to-S3-
CodeDeploy-microfocus-aws-readonly configured under Configure Instance Details. Also verify you have a 
tag assigned with Key CodeDeployGroup and Value ETS-MF-AWS-CICD. 

 

 

5.2 DEPLOY to TEST – AWS CodeDeploy configuration 
In the EDz Bankdemo project, under AWS-CICD folder, create three files: appspec.yml, codedeploy-
before-install.bat, codedeploy-after-install.bat 

 

 

appspec.yml content: 

version: 0.0 
os: windows 
files: 
  - source: .\dll 
    destination: .\dll-staging 
hooks: 
  BeforeInstall: 
    - location: \codedeploy-before-install.bat 
      timeout: 120 
  AfterInstall: 
    - location: \codedeploy-after-install.bat 
      timeout: 120   

The application specification file (AppSpec file) is a YAML-formatted or JSON-formatted file used by 
CodeDeploy to manage a deployment. Documentation about it is available here: 

https://docs.amazonaws.cn/en_us/codedeploy/latest/userguide/reference-appspec-file.html  

 

codedeploy-before-install.bat content: 
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C:\"Program Files (x86)"\"Micro Focus"\"Enterprise Test Server"\bin\casstop /lBANKDEMO 
mkdir .\dll-staging 
ping 127.0.0.1 -n 30 -w 1000 > NUL 

 

codedeploy-after-install.bat content: 

copy  /b/v/y  .\dll-staging\*  C:\BankDemo\System\SysLoadlib 
C:\"Program Files (x86)"\"Micro Focus"\"Enterprise Test Server"\bin\casstart /rBANKDEMO 
ping 127.0.0.1 -n 30 -w 1000 > NUL 

 

Then Commit and Push these file changes making sure the new files are staged. 

Then make a Build in CodeBuild to update the artifacts in S3. 

 

From the AWS console, go to Developer Tools, CodeDeploy, then Applications. 

Click Create application. 

For the Application name, enter: ETS-for-MF-AWS-CICD. 

For the Compute platform, select EC2/On-premises. 

 

Click Create application. 

 

Under the ETS-for-MF-AWS-CICD, select Create deployment group. 

Enter deployment group name: ETS-EC2-instances-MF-AWS-CICD 

Enter service role ARN previously created such as arn:aws:iam::954254376221:role/CodeDeploy-to-EC2-
microfocus-aws 

Deployment type is In-place. 

Environment configuration is Amazon EC2 instances only. 

For the tag, the Key is CodeDeployGroup and Value is ETS-EC2-instances-MF-AWS-CICD. 
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You can verify it found the ETS instance accordingly: 

 

Deployment settings is CodeDeployDefault.AllAtOnce. 

Deselect Load balancer which are not used here. 
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Then click Create Deployment group. 

 

 

Under CodeDeploy -> Applications -> Application -> ETS-for-MF-AWS-CICD select the Deployments tab, 
then click Create deployment. 
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For Deployment group, choose: ETS-EC2-instances-MF-AWS-CICD 

For Revision location, enter: s3://mf-aws-cicd-artifacts/MF-AWS-CICD-Build/deploy.zip 

Revision file type is .zip 

We don’t need to override the content because the codedeploy-after-install.bat script takes care of it. 

Then click Create deployment. 
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Clicking View events, you can see the details of the deployment. 

 

 

Then you can verify that the dll files have been updated in the ETS C:\BankDemo\System\SysLoadlib 
folder. 

 

If you need to troubleshoot the CodeDeploy agent, the downloaded files and logs are under 
C:\ProgramData\Amazon\CodeDeploy. 

5.3 DEPLOY to TEST – AWS CodePipeline configuration 
 

In CodePipeline, select the MF-AWS-CICD-Pipeline and click Edit. 
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Click Add stage after the Build stage. 

 

Enter stage name: Deploy-to-Test 

Click Add stage. 

For this new stage, click Add action group. 

Enter action name: Deploy-to-Test    

Select Deploy provider AWS CodeDeploy 

Select Input artifacts: BuildArtifact 

Select Application name ETS-for-MF-AWS-CICD 

Select Deployment group ETS-EC2-instances-MF-AWS-CICD 

 

Click Done 

Save the modified pipeline. 
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As soon as there is a code change pushed into CodeCommit, the pipeline executes. 
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6 TEST stage 
6.1 TEST – MF ETS configuration for automated tests 
Tests are launched from this batch script: C:\BankDemo\Test\BankDemo-Tests.bat which will be called by 
CodePipeline, via Lambda and AWS Systems Manager (SSM). 

For getting access to Micro Focus software, please contact your Micro Focus representative or contact 
Micro Focus following this link: https://www.microfocus.com/en-us/contact/contactme   

First you need to retrieve Micro Focus Rumba+ Office and VB Add-on software installer. 

If not already installed on ETS instance, install Rumba prerequisites, Rumba+ Desktop Office, and VB Add-
on. 

 

Reboot ETS instance from AWS console. 

 

Start the BankDemo server: 

C:\"Program Files (x86)"\"Micro Focus"\"Enterprise Test Server"\bin\casstart /rBANKDEMO 

 

If any server start problem you can check the console log in C:\BankDemo\System\Logs\console.txt. 

 

Start Rumba+ Desktop. 

Configure a TN3270 to IP address 127.0.0.1 and port 5555. 
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Then connect with this connection. 

 

Verify it connects successfully and that you can run manual tests. 

 

If you need to record Rumba test script, record a macro and then save it under Visual Basic Script format 
in order to save it to a folder. 
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Create a test script in C:\BankDemo\Test\BankDemoTest1.vbs 
WScript.StdOut.WriteLine "Connecting Rumba session..." 
sessType = Conn_3270 
Set app = CreateObject("MicroFocus.Rumba") 
If app.GetSessionType(app.ActiveSessionID) = sessType Then 
    Set session = app.GetSession(app.ActiveSessionID) 
Else 
    sessID = app.CreateSession(sessType) 
    Set session = app.GetSession(sessID) 
End if 
 
session.HostName = "127.0.0.1" 
session.Port = 5555 
session.Connect() 
WScript.StdOut.WriteLine "Session connected." 
 
WScript.StdOut.WriteLine "Interacting with screens..." 
WaitScreen "This is the Micro Focus ES/MTO region", DefaultConnectionTimeout, 1, 2, SearchOnlyAt, False, Empty, Empty 
session.SendKey "Clear" 
WaitScreenTimeout DefaultScreenTimeout 
session.TypeText "bank" 
session.SendKey "Enter" 
WaitScreen "User id.....:", DefaultScreenDataTimeout, 10, 30, SearchOnlyAt, False, 10, 44 
session.TypeText "b0001v" 
session.SendKey "Enter" 
WaitScreen "        **********************************            ", DefaultScreenDataTimeout, 2, 17, SearchOnlyAt, False, 8, 4 
'WaitScreen "        MISMATCH************************            ", DefaultScreenDataTimeout, 2, 17, SearchOnlyAt, False, 8, 4 
session.TypeText "/" 
session.SendKey "Enter" 
WaitScreen "450061494  ", DefaultScreenDataTimeout, 11, 8, SearchOnlyAt, False, 11, 3 
session.TypeText "/" 
session.SendKey "Enter" 
WaitScreen "Scrn:", DefaultScreenDataTimeout, 1, 2, SearchOnlyAt, False, Empty, Empty 
session.SendKey "PF4" 
WaitScreen "450061494  ", DefaultScreenDataTimeout, 11, 8, SearchOnlyAt, False, Empty, Empty 
session.SendKey "Tab" 
session.TypeText "/" 
session.SendKey "Enter" 
WaitScreen "Scrn:", DefaultScreenDataTimeout, 1, 2, SearchOnlyAt, False, Empty, Empty 
session.SendKey "PF4" 
WaitScreen "450061494  ", DefaultScreenDataTimeout, 11, 8, SearchOnlyAt, False, Empty, Empty 
session.SendKey "PF4" 
WaitScreen "        **********************************            ", DefaultScreenDataTimeout, 2, 17, SearchOnlyAt, False, Empty, 
Empty 
session.SendKey "Tab" 
session.SendKey "Tab" 
session.SendKey "Tab" 
session.TypeText "/" 
session.SendKey "Enter" 
WaitScreen "The amount you would like to borrow...:", DefaultScreenDataTimeout, 8, 6, SearchOnlyAt, False, 8, 46 
session.TypeText "10000" 
session.SendKey "Tab" 
session.TypeText "4.25" 
session.SendKey "Tab" 
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session.TypeText "24" 
session.SendKey "Enter" 
WaitScreen "The amount you would like to borrow...:", DefaultScreenDataTimeout, 8, 6, SearchOnlyAt, False, Empty, Empty 
session.SendKey "PF4" 
WaitScreen "        **********************************            ", DefaultScreenDataTimeout, 2, 17, SearchOnlyAt, False, Empty, 
Empty 
session.SendKey "PF4" 
WaitScreen "User id.....:", DefaultScreenDataTimeout, 10, 30, SearchOnlyAt, False, Empty, Empty 
session.SendKey "PF3" 
WaitScreenTimeout DefaultScreenTimeout 
WScript.StdOut.WriteLine "Screen interactions completed." 
 
session.Disconnect() 
WScript.StdOut.WriteLine "Session disconnected." 
 
lResult = CreateObject("WScript.Shell").Run("taskkill /f /im RumbaPage.exe", 0, True) 
WScript.StdOut.WriteLine "Rumba process killed." 
WScript.StdOut.WriteLine "BANKDEMO TESTS COMPLETED WITH SUCCESS" 
 
Const DefaultScreenTimeout = 3000 
Const DefaultScreenDataTimeout = 10000 
Const DefaultConnectionTimeout = 10000 
 
Const SearchAnywhere = 0 
Const SearchStartingAt = 1 
Const SearchOnlyAt = 2 
 
Const ErrorCodeScreenTimeout = 1 
Const ErrorCodeSessionDisconnected = 2 
Const ErrorCodeHostBusy = 3 
 
Const Conn_3270 = 1 
Const Conn_5250 = 2 
Const Conn_VAX = 3 
Const Conn_Other = 4 
 
Function GetScreenPosition(row, column) 
    Dim rows 
    Dim columns 
    session.GetScreenSize rows, columns 
    GetScreenPosition = (columns*(row-1)) + column 
End Function 
 
Function ScreenMatch(textToSearch, row, column, searchCriteria, ignoreCase) 
    screenPosition = 1 
    If (searchCriteria = SearchStartingAt Or searchCriteria = SearchOnlyAt) And Not IsEmpty(row) And Not IsEmpty(column) Then 
        screenPosition = GetScreenPosition(row, column) 
    End if 
 
    If (searchCriteria = SearchStartingAt Or searchCriteria = SearchOnlyAt) And (IsEmpty(row) Or IsEmpty(column)) Then 
        Dim currentRow 
        Dim currentColumn 
        session.GetCursorPosition currentRow, currentColumn 
        If (searchCriteria = SearchStartingAt) Then currentColumn = 1 
        screenPosition = GetScreenPosition(currentRow, currentColumn) 
    End if 
     
    textToSearchTemp = textToSearch 
    screenTextTemp = session.ScreenText 
    If ignoreCase = True Then 
        textToSearchTemp = UCase(textToSearchTemp) 
        screenTextTemp = UCase(screenTextTemp) 
    End if 
     
    If searchCriteria = SearchOnlyAt Then 
        ScreenMatch = Mid(screenTextTemp, screenPosition, Len(textToSearchTemp)) = textToSearchTemp 
    Else 
        ScreenMatch = InStr(screenPosition, screenTextTemp, textToSearchTemp) <> 0 
    End if 
End Function 
 
Sub WaitScreen(textToSearch, timeout, row, column, searchCriteria, ignoreCase, cursorPosRowToWait, cursorPosColumnToWait) 
    Dim timePassed 
    Dim screenFound 
    Dim cursorPosMatch 
    Dim cursorRow, cursorColumn 
    timePassed = 0 
   
    Do 
        WScript.Sleep 100 
        timePassed = timePassed + 100 
        screenFound = ScreenMatch(textToSearch, row, column, searchCriteria, ignoreCase) 
        If IsEmpty(cursorPosRowToWait) Or IsEmpty(cursorPosColumnToWait) Then 
            cursorPosMatch = True 
        Else 
            session.GetCursorPosition cursorRow, cursorColumn 
            cursorPosMatch = (cursorRow = cursorPosRowToWait And cursorColumn = cursorPosColumnToWait) 
        End If 
    Loop Until (session.HostReady = True And screenFound = True And cursorPosMatch = True) Or timePassed >= timeout 
     
    If session.Connected = False Then Call Quit(ErrorCodeSessionDisconnected) 
    If session.HostReady = False Then Call Quit(ErrorCodeHostBusy) 
    If screenFound = False Then Call Quit(ErrorCodeScreenTimeout) 
End Sub 
 
Sub WaitScreenTimeout(timeout) 
    Dim timePassed 



Amazon Web Service – Micro Focus   Page 72 of 95 
COBOL CI/CD Pipeline Configuration Guide V1.1 

    timePassed = 0 
 
    Do 
        WScript.Sleep 100 
        timePassed = timePassed + 100 
    Loop Until timePassed >= timeout 
 
    If session.Connected = False Then Call Quit(ErrorCodeSessionDisconnected) 
    If session.HostReady = False Then Call Quit(ErrorCodeHostBusy) 
End Sub 
 
Function PromptForHiddenText(prompt, caption) 
    Set objHiddenText = CreateObject( "MicroFocus.HiddenInput" ) 
    txt = objHiddenText.GetInput(prompt, caption) 
    If txt = Empty Then WScript.Quit 
    PromptForHiddenText = txt 
End Function 
 
Sub Quit(ErrorCode) 
    If ErrorCode = ErrorCodeScreenTimeout Then WScript.StdErr.Write "ERROR - Screen timeout or screen mismatch." 
    If ErrorCode = ErrorCodeSessionDisconnected Then WScript.StdErr.Write "ERROR - Session disconnected." 
    If ErrorCode = ErrorCodeHostBusy Then WScript.StdErr.Write "ERROR - Host busy." 
 
    WScript.Quit 
End Sub 
 

Create a batch file calling this script in C:\BankDemo\Test\BankDemo-Tests.bat 

echo "Running BankDemo tests in BankDemoTest1.vbs" 
cscript C:\BankDemo\Test\BankDemoTest1.vbs 

 

Verify the test script runs successfully by running the BankDemo-Tests.bat file. 

 

 

 

6.2 TEST – MF ETS configuration for SSM 
AWS Lambda uses AWS Systems Manager (SSM) to launch the batch script on the ETS server. Hence we 
configure SSM first. 

 

Create an IAM role named EC2-to-S3-CodeDeploy-SSM which contains an inline policy with this JSON: 

{ 
    "Version": "2012-10-17", 
    "Statement": [ 
        { 
            "Effect": "Allow", 
            "Action": [ 
                "s3:Get*", 
                "s3:List*" 
            ], 
            "Resource": [ 
                "arn:aws:s3:::mf-aws-cicd-artifacts/*", 
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                "arn:aws:s3:::aws-codedeploy-us-east-2/*", 
                "arn:aws:s3:::aws-codedeploy-us-east-1/*", 
                "arn:aws:s3:::aws-codedeploy-us-west-1/*", 
                "arn:aws:s3:::aws-codedeploy-us-west-2/*", 
                "arn:aws:s3:::aws-codedeploy-ca-central-1/*", 
                "arn:aws:s3:::aws-codedeploy-eu-west-1/*", 
                "arn:aws:s3:::aws-codedeploy-eu-west-2/*", 
                "arn:aws:s3:::aws-codedeploy-eu-west-3/*", 
                "arn:aws:s3:::aws-codedeploy-eu-central-1/*", 
                "arn:aws:s3:::aws-codedeploy-ap-east-1/*", 
                "arn:aws:s3:::aws-codedeploy-ap-northeast-1/*", 
                "arn:aws:s3:::aws-codedeploy-ap-northeast-2/*", 
                "arn:aws:s3:::aws-codedeploy-ap-southeast-1/*", 
                "arn:aws:s3:::aws-codedeploy-ap-southeast-2/*", 
                "arn:aws:s3:::aws-codedeploy-ap-south-1/*", 
                "arn:aws:s3:::aws-codedeploy-sa-east-1/*", 
                "arn:aws:s3:::codepipeline-us-east-2-*", 
                "arn:aws:s3:::codepipeline-us-east-1-*", 
                "arn:aws:s3:::codepipeline-us-west-1-*", 
                "arn:aws:s3:::codepipeline-us-west-2-*", 
                "arn:aws:s3:::codepipeline-ca-central-1-*", 
                "arn:aws:s3:::codepipeline-eu-west-1-*", 
                "arn:aws:s3:::codepipeline-eu-west-2-*", 
                "arn:aws:s3:::codepipeline-eu-west-3-*", 
                "arn:aws:s3:::codepipeline-eu-central-1-*", 
                "arn:aws:s3:::codepipeline-ap-east-1-*", 
                "arn:aws:s3:::codepipeline-ap-northeast-1-*", 
                "arn:aws:s3:::codepipeline-ap-northeast-2-*", 
                "arn:aws:s3:::codepipeline-ap-southeast-1-*", 
                "arn:aws:s3:::codepipeline-ap-southeast-2-*", 
                "arn:aws:s3:::codepipeline-ap-south-1-*", 
                "arn:aws:s3:::codepipeline-sa-east-1-*" 
            ] 
        } 
    ] 
} 

Also attach the AmazonSSMManagedInstanceCore managed policy to this role. 

 

 

Check if the SSM agent is running on the ETS instance by checking of you see activity in the agent logs in 
C:\ProgramData\Amazon\SSM\Logs. If no log, follow the instructions to install the SSM agent on 
Windows: 

https://docs.aws.amazon.com/systems-manager/latest/userguide/sysman-install-win.html 
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Either launch the ETS instance and attach the role EC2-to-S3-CodeDeploy-SSM, or change the IAM role for 
the running instance under Instance Settings -> Attach/Replace IAM Role, selecting EC2-to-S3-
CodeDeploy-SSM and Apply. 

 

 

 

Verify the ETS instance has the tag with key CodeDeployGroup and value ETS-EC2-instances-MF-AWS-
CICD. 

Stop and Start the ETS instance with the SSM agent. 

Verify that the ETS instance shows up under AWS Systems Manager => Instances and Nodes => 
Managed Instances: 

 

 

Test the SSM configuration with such AWS CLI command: 

aws ssm send-command --document-name "AWS-RunPowerShellScript" --document-version "1" --
targets '[{"Key":"tag:CodeDeployGroup","Values":["ETS-EC2-instances-MF-AWS-CICD"]}]' --
parameters '{"commands":["echo Test"],"workingDirectory":[""],"executionTimeout":["3600"]}' -
-timeout-seconds 600 --max-concurrency "50" --max-errors "0" --cloud-watch-output-config 
'{"CloudWatchOutputEnabled":true}' --region us-east-1 

You can verify the successful completion of this command on the instance via AWS Systems Manager => 
Run Command => Command history, and then selection the command that was run and the instance. 
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6.3 TEST – AWS Lambda configuration 
We now create a Lambda function to execute a command on an EC2 instance. 

 

In IAM, create an IAM role named Lambda-SSM-EC2-Logs which contains an inline policy with this JSON: 

{ 
    "Version": "2012-10-17", 
    "Statement": [ 
        { 
            "Effect": "Allow", 
            "Action": [ 
                "ssm:SendCommand", 
                "ssm:GetCommandInvocation", 
                "ec2:DescribeInstances", 
                "ec2:DescribeInstanceStatus", 
                "codepipeline:PutJobSuccessResult", 
                "codepipeline:PutJobFailureResult", 
                "logs:CreateLogGroup", 
                "logs:CreateLogStream", 
                "logs:PutLogEvents" 
            ], 
            "Resource": "*" 
        } 
    ] 
} 
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In Lambda, create a Lambda function named CodePipeline-Lambda-SSM-EC2-RunPowerShellScript.  

Select Runtime Node.js 12.x. 

Select the Lambda-SSM-EC2-Logs existing role. 
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Click Create function. 

 

Enter code inline index.js: 
const AWS = require('aws-sdk'); 
const ssm = new AWS.SSM(); 
const ec2 = new AWS.EC2(); 
const waitInterval = 1 
const timeoutSSM = 300 
var jobId 
var jobUserParameters     
 
exports.handler = async (event, context) => { 
    const instanceIds = []; 
    var instanceTagKey = 'CodeDeployGroup' 
    var instanceTagValue = 'ETS-EC2-instances-MF-AWS-CICD' 
    var command = "& C:\\BankDemo\\Test\\BankDemo-Tests.bat" 
    var instanceId 
    var codepipeline = new AWS.CodePipeline() 
    var runEc2CommandOneSuccess = false 
     
    console.log('Received event ', JSON.stringify(event)) 
    try { 
        jobId = event["CodePipeline.job"].id 
        console.log('Found CodePipeline job with ID: ', jobId) 
        jobUserParameters = JSON.parse(event["CodePipeline.job"].data.actionConfiguration.configuration.UserParameters) 
        console.log('Found CodePipeline job with parameters: ', jobUserParameters) 
        instanceTagKey = jobUserParameters.Ec2TagKey 
        instanceTagValue = jobUserParameters.Ec2TagValue 
        command = jobUserParameters.Ec2Command 
        if ((!instanceTagKey) || (!instanceTagValue) || (!command)) { console.error('Error trying to retrieve CodePipeline user parameters. In 
CodePipeline, the User Parameters must be in JSON format following {"Ec2TagKey": "myTagKey", "Ec2TagValue": "myTagValue", "Ec2Command": "& 
C:\\myPath\\myCommand.bat"}.') } 
    } catch (error) { 
        console.error('Error trying to retrieve CodePipeline parameters. In CodePipeline, the User Parameters must be in JSON format following 
{"Ec2TagKey": "myTagKey", "Ec2TagValue": "myTagValue", "Ec2Command": "& C:\\myPath\\myCommand.bat"}. Continuing with default Lambda function values. 
Catched error: ', error.toString()) 
    } 
    try { 
             
            var tagFilter = { Filters: [ { Name: 'tag:' + instanceTagKey, Values: [ instanceTagValue ] } ] }; 
            const instancesData = await ec2.describeInstances(tagFilter).promise(); 
            instancesData.Reservations.forEach(reservation => { 
                reservation.Instances.forEach(instance => { 
                    //console.log('Looking at instance: ', instance.InstanceId) 
                    if (instance.State.Code === 16) { 
                        // 0: pending, 16: running, 32: shutting-down, 48: terminated, 64: stopping, 80: stopped 
                        instanceIds.push(instance.InstanceId); 
                        console.log('Instance found running with tag { ' + instanceTagKey + ': ' + instanceTagValue + ' } :', instance.InstanceId) 
                    } 
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                 }); 
            }); 
            //console.log('instanceIds: ', instanceIds) 
            if (instanceIds.length == 0) { 
                 console.error('No instance found with status Running and tag { ', instanceTagKey, ': ', instanceTagValue , ' }') 
            } else { 
 
                for (instanceId of instanceIds) { 
                    // Send command to EC2 instance via SSM 
                    const sendCommandPromise = ssm.sendCommand({ 
                           DocumentName: "AWS-RunPowerShellScript", 
                           InstanceIds: [ instanceId ], 
                           Parameters: {  "commands": [ command ], "workingDirectory": [  "" ] }, 
                           TimeoutSeconds: timeoutSSM 
                           }).promise(); 
                    console.log(instanceId, ' - SSM command sent to instance') 
                    console.log(instanceId, ' - PowerShell command sent: ', command) 
                    const sendCommandResult = await sendCommandPromise 
                    const commandId = sendCommandResult.Command.CommandId 
         
                    var commandStatus = '' 
                    var getCommandInvocationResult 
                    do { 
                        console.log(instanceId, ' - Waiting for SSM response...') 
                        await new Promise(resolve => setTimeout(resolve, waitInterval * 1000)); 
                        const getCommandInvocationPromise = ssm.getCommandInvocation({ CommandId: commandId, InstanceId: instanceId}).promise(); 
                        getCommandInvocationResult = await getCommandInvocationPromise 
                        //console.log('getCommandInvocationResult: ', getCommandInvocationResult) 
                        commandStatus = getCommandInvocationResult.Status 
                        console.log(instanceId, ' - SSM command status: ', commandStatus) 
                        //if (commandStatus == 'Success') { console.log('getCommandInvocationResult: ', getCommandInvocationResult) } 
                    } while ((commandStatus != 'Success') && (commandStatus != 'Cancelled') && (commandStatus != 'TimedOut') && (commandStatus != 
'Failed')); 
                    if (commandStatus == 'Success') {  
                        if (getCommandInvocationResult.StandardErrorContent.length == 0) { 
                            runEc2CommandOneSuccess = true 
                            console.log(instanceId, ' - Command successfully executed via SSM.') 
                            console.log(instanceId, ' - Command StdOut: ', getCommandInvocationResult.StandardOutputContent) 
                            console.log(instanceId, ' - Command StdErr: ', getCommandInvocationResult.StandardErrorContent) 
                        } else { 
                            console.error(instanceId, ' - Command executed via SSM, but generated an error.') 
                            console.error(instanceId, ' - Command StdOut: ', getCommandInvocationResult.StandardOutputContent) 
                            console.error(instanceId, ' - Command StdErr: ', getCommandInvocationResult.StandardErrorContent) 
                        } 
                    } else { 
                        console.error(instanceId, ' - SSM command failed.') 
                        console.error(instanceId, ' - SSM ResponseCode: ', getCommandInvocationResult.ResponseCode) 
                        console.error(instanceId, ' - SSM Status: ', getCommandInvocationResult.Status) 
                        console.error(instanceId, ' - SSM StatusDetails: ', getCommandInvocationResult.StatusDetails) 
                    }      
                } 
            } 
         
        if (runEc2CommandOneSuccess) { 
            console.log('One command execution on an EC2 instance was successful.') 
            if (jobId) { 
                console.log('Sending putJobSuccessResult to CodePipeline.') 
                await codepipeline.putJobSuccessResult({ jobId }).promise()     
            }     
        } else { 
            console.error('Command execution on EC2 instance(s) was unsuccessful.') 
            if (jobId) { 
                console.log('Sending putJobFailureResult to CodePipeline.') 
                await codepipeline.putJobFailureResult({jobId, failureDetails: {message: 'Script error. See Command StdErr for details', type: 
'JobFailed', externalExecutionId: context.invokeid}}).promise() 
            } 
        } 
         
    } catch (error) { 
        console.error('Error caught during Lambda function execution:', error.toString()) 
        if (jobId) { 
                   console.log('Sending putJobFailureResult to CodePipeline.') 
                   await codepipeline.putJobFailureResult({jobId, failureDetails: {message: error.toString(), type: 'JobFailed', externalExecutionId: 
context.invokeid}}).promise() 
        } else { 
           throw error  
        } 
    } 
} 

 

Tailor the instanceTagKey, instanceTagValue, command variables to your specific environment. 

For the Execution role, verify the existing role Lambda-SSM-EC2-Logs is selected. 

Edit the Basic setting timeout, select 5 min 30 sec. 

Save the function. 

Click Test to run this new function. Verify it runs successfully. 

6.4 TEST – AWS CodePipeline configuration 
 

In CodePipeline, go to the MF-AWS-CICD-Pipeline and click Edit.  

Add a stage after the Deploy stage. 
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For this new Test stage, click Add action group. 

 

Action name is: Test 

Action provider is: AWS Lambda 

Region is the region used for the ETS EC2 instance. 

Function name is: CodePipeline-Lambda-SSM-EC2-RunPowerShellScript 

Under User parameters, enter the JSON string specifying the tag and the test command: 

{"Ec2TagKey": "CodeDeployGroup", "Ec2TagValue": "ETS-EC2-instances-MF-AWS-CICD", 
"Ec2Command": "& C:\\BankDemo\\Test\\BankDemo-Tests.bat"} 

 

Click Done. 

Click Done for the Stage. 

Click Save for the pipeline. 
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Click Release change to re-run the last code change through the pipeline with the new Test stage. 

 



Amazon Web Service – Micro Focus   Page 81 of 95 
COBOL CI/CD Pipeline Configuration Guide V1.1 

7 DEPLOY to PROD stage 
7.1 DEPLOY to PROD – AWS Lambda configuration 
We now create a Lambda function to pull the changed files from CodeCommit and process them for 
deployment to production. 

 

This section allows developing custom code in the Lambda function to deploy the code to production. In 
case you want to upload the source code files to z/OS via the z/OS FTP server, please refer to the next 
section. 

 

In IAM, create an IAM role named Lambda-CodeCommit-CodePipeline-Logs which contains an inline policy 
with this JSON: 

{ 
    "Version": "2012-10-17", 
    "Statement": [ 
        { 
            "Effect": "Allow", 
            "Action": [ 
                "codecommit:Get*", 
                "codecommit:List*", 
                "codecommit:DescribePullRequestEvents", 
                "codecommit:GitPull", 
                "codecommit:BatchGetRepositories", 
                "codecommit:BatchGetPullRequests", 
                "codepipeline:PutJobSuccessResult", 
                "codepipeline:PutJobFailureResult", 
                "logs:CreateLogGroup", 
                "logs:CreateLogStream", 
                "logs:PutLogEvents" 
            ], 
            "Resource": "*" 
        } 
    ] 
} 
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In Lambda, create a Lambda function named CodePipeline-Lambda-CodeCommit-DeployToProd.  

Select Runtime Node.js 12.x. 

Select the Lambda-CodeCommit-CodePipeline-Logs existing role. 
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Click Create function. 

 

Enter code inline index.js: 
const AWS = require('aws-sdk'); 
var jobId 
var commitId = '4aae84ccb0c0d59d9aa133dc85f076357993822c'  
var repositoryName = 'MF-AWS-CICD-SCM' 
var jobUserParameters    
var differencesData 
var difference 
 
 
exports.handler = async (event, context) => { 
    var codepipeline = new AWS.CodePipeline() 
    var codecommit = new AWS.CodeCommit() 
 
    console.log('Received event ', JSON.stringify(event)) 
    try { 
        jobId = event["CodePipeline.job"].id 
        console.log('Found CodePipeline job with ID: ', jobId) 
        jobUserParameters = JSON.parse(event["CodePipeline.job"].data.actionConfiguration.configuration.UserParameters) 
        console.log('Found CodePipeline job with parameters: ', jobUserParameters) 
        commitId = jobUserParameters.commitId 
        console.log('Found CodeCommit CommitId: ', commitId) 
        repositoryName = jobUserParameters.repositoryName 
        console.log('Found CodeCommit RepositoryName: ', repositoryName) 
        if ((!commitId) || (!repositoryName) ) { console.error('Error trying to retrieve CodePipeline user parameters. In 
CodePipeline, the User Parameters must be { "commitId": "#{SourceVariables.CommitId}", "repositoryName": 
"#{SourceVariables.RepositoryName}" }.') } 
    } catch (error) { 
        console.error('Error trying to retrieve CodePipeline parameters. In CodePipeline, the User Parameters must be { 
"commitId": "#{SourceVariables.CommitId}", "repositoryName": "#{SourceVariables.RepositoryName}" }. Continuing with default 
Lambda function values. Catched error: ', error.toString()) 
    } 
 
    try { 
             
        console.log('commitId:', commitId) 
        const commitData = await codecommit.getCommit({ commitId: commitId, repositoryName: repositoryName }).promise() 
        //console.log(commitData) 
        console.log('Commit message:', commitData.commit.message) 
        if (commitData.commit.parents[0].length > 0) {  
            const priorCommitId = commitData.commit.parents[0]  
            console.log('priorCommitId:', priorCommitId) 
            differencesData = await codecommit.getDifferences({ repositoryName: repositoryName, afterCommitSpecifier: commitId, 
beforeCommitSpecifier: priorCommitId }).promise() 
        } else { 
            differencesData = await codecommit.getDifferences({ repositoryName: repositoryName, afterCommitSpecifier: commitId 
}).promise() 
        } 
        //console.log('differencesData:', differencesData) 
  
        for (difference of differencesData.differences) { 
            //console.log('Processing difference:', difference) 
            if (difference.changeType == 'A') { 
                console.log('Processing DeployToProd file add:', difference.afterBlob.path ) 
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                console.log('Processing DeployToProd file add with blobId:', difference.afterBlob.blobId ) 
                const blobData = await codecommit.getBlob({ blobId: difference.afterBlob.blobId, repositoryName: repositoryName 
}).promise() 
                const blobContent = blobData.content 
                console.log('blobContent:', blobContent) 
                // Add your code addition logic here 
         
            } else if (difference.changeType == 'M') { 
                console.log('Processing DeployToProd file modify:', difference.afterBlob.path ) 
                console.log('Processing DeployToProd file modify with blobId:', difference.afterBlob.blobId ) 
                const blobData = await codecommit.getBlob({ blobId: difference.afterBlob.blobId, repositoryName: repositoryName 
}).promise() 
                const blobContent = blobData.content 
                console.log('blobContent:', blobContent) 
                // Add your code modification logic here 
 
            } else if (difference.changeType == 'D') { 
                console.log('Processing DeployToProd file delete:', difference.afterBlob.path ) 
                console.log('Processing DeployToProd file delete with blobId:', difference.afterBlob.blobId ) 
                // Add your code deletion logic here 
                 
            } else { 
                console.log('changeTyoe not processed: ', difference.changeType) 
            } 
        } 
 
 
        if (jobId) { 
            console.log('Sending putJobSuccessResult to CodePipeline.') 
            await codepipeline.putJobSuccessResult({ jobId }).promise()     
        }     
 
    } catch (error) { 
        console.error('Error caught during Lambda function execution:', error.toString()) 
        if (jobId) { 
                   console.log('Sending putJobFailureResult to CodePipeline.') 
                   await codepipeline.putJobFailureResult({jobId, failureDetails: {message: error.toString(), type: 'JobFailed', 
externalExecutionId: context.invokeid}}).promise() 
        } else { 
           throw error  
        } 
    } 
} 

 

Edit the Basic setting timeout, select 1min. 

Save the function. 

Click Test to run this new function. Verify it runs successfully 

 

7.2 DEPLOY to PROD via z/OS FTP – AWS Lambda 
configuration 

 

In this section we describe how to configure the Lambda function for uploading the source code to z/OS 
via the z/OS FTP server which comes with z/OS Communication Server. 

 

In IAM, create an IAM role named Lambda-CodeCommit-CodePipeline-Logs which contains an inline policy 
with this JSON: 

{ 
    "Version": "2012-10-17", 
    "Statement": [ 
        { 
            "Effect": "Allow", 
            "Action": [ 
                "codecommit:Get*", 
                "codecommit:List*", 
                "codecommit:DescribePullRequestEvents", 
                "codecommit:GitPull", 
                "codecommit:BatchGetRepositories", 
                "codecommit:BatchGetPullRequests", 
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                "codepipeline:PutJobSuccessResult", 
                "codepipeline:PutJobFailureResult", 
                "logs:CreateLogGroup", 
                "logs:CreateLogStream", 
                "logs:PutLogEvents" 
            ], 
            "Resource": "*" 
        } 
    ] 
} 

 

 

Now we prepare the ftp client node.js module we will use with the Lambda function. 

On a Linux/Unix/Mac terminal, package the promise-ftp module with the following commands: 

mkdir lambda-layer-promise-ftp 
cd lambda-layer-promise-ftp 
mkdir nodejs 
cd nodejs 
npm init 
npm install --save promise-ftp 

There is a bug (documented here) in this promise-ftp module we need to fix. Open the 
node_modules@icetee\ftp\lib\connection.js file and replace this statement: 

this._send(pasvCmd, function (err, text) { 

With this statement: 

this._send(pasvCmd, function reentry(err, text) { 
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Once this is done, compress/zip the nodejs folder creating a nodejs.zip archive. 

Back into AWS console, within Lambda, create a Lambda Layer for the promise-ftp module with 
compatible runtimes for nodejs10.x and nodejs12.x. 

 

 

In Lambda, create a Lambda function named CodePipeline-Lambda-CodeCommit-FTPtoZOS.  

Select Runtime Node.js 12.x. 

Select the Lambda-CodeCommit-CodePipeline-Logs existing role. 
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Click Create function. 

Under the Designer tab, click Layers, then Add a layer. 

 

Select the promise-ftp layer and click Add. 
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The 1 layer then appears next to the Lambda function name. 

Enter code inline index.js: 
const AWS = require('aws-sdk'); 
const path = require('path'); 
var promiseFtp = require("promise-ftp"); 
var jobId 
var commitId = '4aae84ccb0c0d59d9aa133dc85f0763579xxxxxx'  
var repositoryName = 'MF-AWS-CICD-SCM' 
var jobUserParameters    
var differencesData 
var difference 
var zOShostname = "x.xxx.xxx.xx"; 
var zOSusername = "USERID"; 
var zOSpassword = "password"; 
var zOSdataset = "'USERID.CICD.SRC'"; 
 
 
exports.handler = async (event, context) => { 
    var codepipeline = new AWS.CodePipeline() 
    var codecommit = new AWS.CodeCommit() 
 
    console.log('Received event ', JSON.stringify(event)) 
    try { 
        jobId = event["CodePipeline.job"].id 
        console.log('Found CodePipeline job with ID: ', jobId) 
        jobUserParameters = 
JSON.parse(event["CodePipeline.job"].data.actionConfiguration.configuration.UserParameters) 
        console.log('Found CodePipeline job with parameters: ', jobUserParameters) 
        commitId = jobUserParameters.commitId 
        console.log('Found CodeCommit CommitId: ', commitId) 
        repositoryName = jobUserParameters.repositoryName 
        console.log('Found CodeCommit RepositoryName: ', repositoryName) 
        if ((!commitId) || (!repositoryName) ) { console.error('Error trying to retrieve CodePipeline user 
parameters. In CodePipeline, the User Parameters must be { "commitId": "#{SourceVariables.CommitId}", 
"repositoryName": "#{SourceVariables.RepositoryName}" }.') } 
    } catch (error) { 
        console.error('Error trying to retrieve CodePipeline parameters. In CodePipeline, the User Parameters 
must be { "commitId": "#{SourceVariables.CommitId}", "repositoryName": "#{SourceVariables.RepositoryName}" }. 
Continuing with default Lambda function values. Catched error: ', error.toString()) 
    } 
 
    try { 
             
        console.log('commitId:', commitId) 
        const commitData = await codecommit.getCommit({ commitId: commitId, repositoryName: repositoryName 
}).promise() 
        //console.log(commitData) 
        console.log('Commit message:', commitData.commit.message) 
        if (commitData.commit.parents[0].length > 0) {  
            const priorCommitId = commitData.commit.parents[0]  
            console.log('priorCommitId:', priorCommitId) 
            differencesData = await codecommit.getDifferences({ repositoryName: repositoryName, 
afterCommitSpecifier: commitId, beforeCommitSpecifier: priorCommitId }).promise() 
        } else { 
            differencesData = await codecommit.getDifferences({ repositoryName: repositoryName, 
afterCommitSpecifier: commitId }).promise() 
        } 
        //console.log('differencesData:', differencesData) 
         
        // Connect to z/OS FTP server 
        var ftp = new promiseFtp() 
            var serverMessage = await ftp.connect({ 
            host: zOShostname, 
            user: zOSusername, 
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            password: zOSpassword, 
            connTimeout: 5000, 
            pasvTimeout: 1000, 
            keepalive: 10000 
        }); 
        console.log('Connection message: '+serverMessage); 
        var asciiResponse = await ftp.ascii(); 
        console.log('Ascii response: '+asciiResponse) 
        var cwdResponse = await ftp.cwd(zOSdataset); 
        console.log('Change working directory response: '+cwdResponse) 
 
             
        for (difference of differencesData.differences) { 
            //console.log('Processing difference:', difference) 
            if (difference.changeType == 'A') { 
                console.log('Processing DeployToProd file add:', difference.afterBlob.path ) 
                console.log('Processing DeployToProd file add with blobId:', difference.afterBlob.blobId ) 
                const blobData = await codecommit.getBlob({ blobId: difference.afterBlob.blobId, 
repositoryName: repositoryName }).promise() 
                const blobContent = blobData.content 
                console.log('blobContent:', blobContent) 
                const fileText = new Buffer.from(blobContent, 'base64').toString('ascii'); 
                //console.log('File text:', fileText) 
                const zosDatasetMemberName = path.basename(difference.afterBlob.path, 
path.extname(difference.afterBlob.path)).substring(0,8).toUpperCase(); 
                console.log('Destination z/OS dataset member name: ', zosDatasetMemberName); 
                await ftp.put(fileText, zosDatasetMemberName); 
         
            } else if (difference.changeType == 'M') { 
                console.log('Processing DeployToProd file modify:', difference.afterBlob.path ) 
                console.log('Processing DeployToProd file modify with blobId:', difference.afterBlob.blobId ) 
                const blobData = await codecommit.getBlob({ blobId: difference.afterBlob.blobId, 
repositoryName: repositoryName }).promise() 
                const blobContent = blobData.content 
                console.log('blobContent:', blobContent) 
                const fileText = new Buffer.from(blobContent, 'base64').toString('ascii'); 
                //console.log('File text:', fileText) 
                const zosDatasetMemberName = path.basename(difference.afterBlob.path, 
path.extname(difference.afterBlob.path)).substring(0,8).toUpperCase(); 
                console.log('Destination z/OS dataset member name: ', zosDatasetMemberName); 
                await ftp.put(fileText, zosDatasetMemberName); 
 
            } else if (difference.changeType == 'D') { 
                console.log('Processing DeployToProd file delete:', difference.afterBlob.path ) 
                console.log('Processing DeployToProd file delete with blobId:', difference.afterBlob.blobId ) 
                const zosDatasetMemberName = path.basename(difference.afterBlob.path, 
path.extname(difference.afterBlob.path)).substring(0,8).toUpperCase(); 
                console.log('Destination z/OS dataset member name: ', zosDatasetMemberName); 
                await ftp.delete(zosDatasetMemberName); 
                 
            } else { 
                console.log('changeTyoe not processed: ', difference.changeType) 
            } 
        } 
 
        //var list = await ftp.list(); 
        //console.log('Directory listing:'+list); 
        var endResponse = await ftp.end(); 
        console.log('End message: '+endResponse); 
 
        if (jobId) { 
            console.log('Sending putJobSuccessResult to CodePipeline.') 
            await codepipeline.putJobSuccessResult({ jobId }).promise()     
        }     
 
    } catch (error) { 
        console.error('Error caught during Lambda function execution:', error.toString()) 
        if (jobId) { 
                   console.log('Sending putJobFailureResult to CodePipeline.') 
                   await codepipeline.putJobFailureResult({jobId, failureDetails: {message: error.toString(), 
type: 'JobFailed', externalExecutionId: context.invokeid}}).promise() 
        } else { 
           throw error  
        } 
    } 
} 

Customize the zOS variables for your specific z/OS FTP server and target PDS dataset. 

For security reasons, the password can be stored in AWS Secrets Manager and retrieved via AWS Secrets 
Manager SDK. 
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Edit the Basic setting timeout, select 1min. 

Save the function. 

Click Test to run this new function. Verify it runs successfully 

 

7.3 DEPLOY to PROD – AWS CodePipeline configuration 
In CodePipeline, we’re now going to add the new stage to deploy the code to the production environment. 
In CodePipeline, then Pipelines, then Pipeline, select MF-AWS-CICD-Pipeline. 

Click Edit. 

After the last stage, at the bottom, click Add stage. 

 

 

Click Add action group. 

 

The Action name is: Deploy-to-Prod 

The Action provider is: AWS Lambda 

Select the proper region for your environment. 

Input artifacts is SourceArtifact 

Function name is: CodePipeline-Lambda-CodeCommit-DeployToProd or CodePipeline-Lambda-
CodeCommit-FTPtoZOS 

User parameters is: { "commitId": "#{SourceVariables.CommitId}", "repositoryName": 
"#{SourceVariables.RepositoryName}" } 
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Click Done. 

Click Done to save the new stage. 

Click Save to save the changed pipeline. 

 

In order to test, you can either commit and push to upstream a new change from EDz, or click Release 
change on the pipeline itself. 
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Once the pipeline completes, we can verify the changes are pushed onto z/OS. 
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8 Appendix 
 

8.1 Configure instance for new Administrator random 
password  

C:\ProgramData\Amazon\EC2-Windows\Launch\Config\LaunchConfig.json 

{ 
  "SetComputerName": false, 
  "SetMonitorAlwaysOn": true, 
  "SetWallpaper": true, 
  "AddDnsSuffixList": true, 
  "ExtendBootVolumeSize": true, 
  "HandleUserData": true, 
  "AdminPasswordType": "Random", 
  "AdminPassword": "" 
} 

C:\ProgramData\Amazon\EC2-Windows\Launch\Settings\Ec2LaunchSettings.exe 

 

Shutdown with Sysprep then create new AMI from stopped instance. 

 

8.2 Powershell script to compile Bankdemo on EDz 
Bankdemo-build.ps1 
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### Documentation: https://www.microfocus.com/documentation/enterprise-developer/ed50pu2/ED-Eclipse/HRCMRHCOML0L.html 
 
### Variables 
$env:SOURCE_COBOL_FOLDER = "C:\Users\Administrator\TestBuild\Bankdemo\Sources\cbl" 
$env:COBOL_EXE_PATH_FILE = "C:\Program Files (x86)\Micro Focus\Enterprise Developer\bin64\cobol.exe" 
$env:CBLLINK_EXE_PATH_FILE = "C:\Program Files (x86)\Micro Focus\Enterprise Developer\bin64\cbllink.exe" 
$env:COBOL_COMPILER_DIRECTIVES = "preprocess(EXCI),CICSECM()" 
$env:COBDIR="C:\Program Files (x86)\Micro Focus\Enterprise Developer\;$env:COBDIR" # where to find the message file 
$env:COBCPY = "C:\Program Files (x86)\Micro Focus\Enterprise Developer\cpylib;$env:COBCPY" # where to find copybooks such as DFHAID 
 
  
 
 
echo "===============================================================================" 
echo "Environment Variables:" 
echo "SOURCE_COBOL_FOLDER: $env:SOURCE_COBOL_FOLDER" 
echo "COBOL_COMPILER_DIRECTIVES: $env:COBOL_COMPILER_DIRECTIVES" 
echo "COBOL_EXE_PATH_FILE: $env:COBOL_EXE_PATH_FILE" 
echo "CBLLINK_EXE_PATH_FILE: $env:CBLLINK_EXE_PATH_FILE" 
echo "COBDIR: $env:COBDIR" 
echo "COBCPY: $env:COBCPY" 
echo "" 
 
echo "===============================================================================" 
echo "Compiling begins" 
foreach ($f in Get-ChildItem $env:SOURCE_COBOL_FOLDER -Filter "*.cbl") {  
   $CBL_FILE =  $f.FullName 
   echo "-------------------------------------------------------------------------------" 
   echo "Compiling $CBL_FILE..." 
   & $env:COBOL_EXE_PATH_FILE "$CBL_FILE,,,$env:COBOL_COMPILER_DIRECTIVES;" 
    
    } 
echo "-------------------------------------------------------------------------------" 
echo "Compilling ends" 
echo "" 
 
echo "===============================================================================" 
echo "Linking begins" 
 
foreach ($f in Get-ChildItem "." -Filter "*.obj") {  
   $OBJ_FILE =  $f.FullName 
   echo "-------------------------------------------------------------------------------" 
   echo "Linking $OBJ_FILE..." 
   & $env:CBLLINK_EXE_PATH_FILE -d $OBJ_FILE 
    
    } 
 echo "-------------------------------------------------------------------------------" 
 echo "Linking ends" 

 


